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Important Information

Warranty
The GPIB hardware is warranted against defects in materials and workmanship for a period of two years from the date 
of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace 
equipment that proves to be defective during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming 
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced 
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not 
execute programming instructions if National Instruments receives notice of such defects during the warranty period. 
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside 
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs 
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully reviewed 
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should 
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages 
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL  INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS 
ANY WARRANTY OF MERCHANTABILITY  OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’ S RIGHT TO RECOVER DAMAGES CAUSED 
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL  INSTRUMENTS SHALL BE LIMITED  TO THE AMOUNT THERETOFORE PAID BY THE 
CUSTOMER. NATIONAL  INSTRUMENTS WILL  NOT BE LIABLE  FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, 
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of 
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. 
Any action against National Instruments must be brought within one year after the cause of action accrues. National 
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty 
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow 
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product; 
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, 
or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, 
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without 
the prior written consent of National Instruments Corporation.

Trademarks
NI-488.2™ is a trademark of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing intended to ensure a level of reliability 
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving medical 
or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part of the 
user or application designer. Any use or application of National Instruments products for or involving medical or clinical 
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeguards, 
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should always 
continue to be used when National Instruments products are being used. National Instruments products are NOT intended 
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard human health 
and safety in medical or clinical treatment.
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About
This

Manual

This manual contains instructions to help you use your current National 
Instruments GPIB interfaces and your NI-488.2 software for DOS or 
Windows with Windows 95 or Windows 98.

This manual assumes that you are already familiar with DOS or Windows, 
and with Windows 95 or Windows 98.

Conventions Used in This Manual
The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options»Substitute 
Fonts directs you to open the File menu, select the Page Setup item, select 
Options, and finally select the Substitute Fonts option from the last 
dialog box.

This icon to the left of bold italicized text denotes a note, which alerts you 
to important information.

bold Bold text denotes the names of menus, menu items, parameters, dialog 
boxes, dialog box buttons or options, icons, windows, Windows tabs, 
or LEDs.

bold italic Bold italic text denotes a note.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept. This font also denotes text from which you supply the 
appropriate word or value, as in Windows 3.x.

monospace Text in this font denotes text or characters that you should literally enter 
from the keyboard, sections of code, programming examples, and syntax 
examples. This font is also used for the proper names of disk drives, paths, 
directories, programs, subprograms, subroutines, device names, functions, 
operations, variables, filenames and extensions, and for statements and 
comments taken from programs.
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About This Manual

monospace bold Bold text in this font denotes the messages and responses that the computer 
automatically prints to the screen. This font also emphasizes lines of code 
that are different from the other examples.

monospace italic Italic text in this font denotes that you must enter the appropriate words or 
values in the place of these items.

Related Documentation
The following documents contain information that you may find helpful as 
you read this manual:

• ANSI/IEEE Standard 488.1-1987, IEEE Standard Digital Interface 
for Programmable Instrumentation

• ANSI/IEEE Standard 488.2-1992, IEEE Standard Codes, Formats, 
Protocols, and Common Commands

• Microsoft MS-DOS User’s Guide, Microsoft Corporation

• Microsoft Windows User’s Guide, Microsoft Corporation

• Your Microsoft Windows 95/98 documentation

You may also need to refer to the getting started manuals that came with 
your National Instruments GPIB interfaces.

Customer Communication
National Instruments wants to receive your comments on our products 
and manuals. We are interested in the applications you develop with our 
products, and we want to help if you have problems with them. To make it 
easy for you to contact us, this manual contains comment and configuration 
forms for you to complete. These forms are in Appendix A, Customer 
Communication, at the end of this manual.
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Chapter

1AT-GPIB

Follow the instructions in this section to use the AT-GPIB and the NI-488.2 
software for DOS or Windows 3 with Windows 95/98. Refer to your 
AT-GPIB getting started manual for additional information about the 
hardware installation.

What You Need to Get Started
❑ Compatibility Release for the NI-488.2 Software for DOS and 

Windows 3 with Windows 95/98 disk

❑ One of the following disks:

– NI-488.2 Software for Windows and the AT-GPIB/TNT+, 
AT-GPIB/TNT(PnP), EISA-GPIB and AT-GPIB/TNT

or

– NI-488.2 Software for DOS and the AT-GPIB/TNT+, 
AT-GPIB/TNT(PnP), EISA-GPIB and AT-GPIB/TNT

❑ Microsoft Windows 95 or Windows 98 installed on your computer

❑ AT-GPIB getting started manual for additional information about the 
hardware installation

Install the Hardware and Software
1. Reserve the resources (I/O, DMA, IRQ) to be used by the AT-GPIB 

hardware.

a. Double-click on the System icon in the Control Panel. You can 
open the Control Panel by choosing Start»Settings»Control 
Panel.

b. In the System Properties dialog box that appears, click on the 
Device Manager tab.

c. Double-click on the Computer icon to bring up the Computer 
Properties dialog box.



Chapter 1 AT-GPIB

Using NI-488.2 with Windows 95/98 1-2 © National Instruments Corporation

d. Select the View Resources tab to determine which resources 
(I/O, IRQ, DMA) are available.

e. Switch to the Reserve Resources tab and select Add to add 
specific I/O, IRQ, and DMA resources. You must reserve I/O 
space for the hardware. Reserving an IRQ level and a DMA 
channel is optional. However, the software performs better if it is 
able to use both DMA and interrupts.

– The AT-GPIB I/O address must be in the range 0x100 to 
0x3E0. 0x20 bytes of contiguous I/O address space are 
required. For example, if you are selecting a base I/O address 
of 0x2C0, enter 2C0 for the Start Value and enter 2DF for 
the End Value. 

– The options for the DMA channel are 5, 6, 7, or none.

– The options for the IRQ level are 3, 4, 5, 6, 7, 9, 10, 11, 12, 
14, 15, or none.

f. Click on the OK  button to exit the Computer Properties 
dialog box.

g. Click on the No button in the System Settings Change 
dialog box.

h. Close the Control Panel.

2. Configure the jumpers and DIP switches on the AT-GPIB to reflect the 
reserved I/O, IRQ and DMA settings. Refer to your getting started 
manual for information about configuring the hardware.

3. Complete the following steps to shut down Windows and install the 
new hardware:

a. Select Shut Down from the Start menu.

b. In the Shut Down Windows dialog box, select the Shut down the 
computer? option, then click on the Yes button.

c. When the screen displays the message It’s now safe to turn off 
your computer, power off the computer.

d. Insert the AT-GPIB hardware. Refer to your AT-GPIB getting 
started manual for installation instructions.

4. Power on the computer.

5. DOS only: Create a DOS Only Prompt shortcut to run the NI-488.2 
for DOS utilities rather than using the DOS Shell from the 
Start»Program»MS-DOS Prompt menu. Many NI-488.2 software 
utilities are combined DOS/Win16 applications. By default, Windows 
runs such combined applications in Win16 mode when executing them 
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in a standard MS-DOS shell. For NI-488.2 for DOS, these combined 
applications must be run in DOS mode. Therefore, you need to create 
a special DOS Only Prompt in which to run the NI-488.2 for DOS 
utilities. Complete the following steps to create the DOS Only 
Prompt shortcut:

a. Right-click on the desktop and select New. From the New menu 
list, select the Shortcut item. The Create Shortcut dialog box 
appears.

b. Click on the Browse button. Find the Dosprmpt item in the 
Windows directory (usually c:\windows ) and double-click on it. 
This initializes Command Line correctly and returns you to the 
Create Shortcut dialog box.

c. Click on the Next button and rename the shortcut icon to DOS 
Only Prompt . 

d. Click on the Finish button to close the Create Shortcut dialog 
box. The DOS Only Prompt icon should appear on the desktop.

e. Right-click on the DOS Only Prompt icon and select the 
Properties menu item.

f. Select the Program tab and click on the Advanced button. The 
Advanced Program Settings dialog box appears.

g. Select the first item, Prevent MS-DOS-based programs from 
detecting Windows. The Suggest MS-DOS mode as necessary 
item should also be selected. Click on the OK  button to exit the 
dialog box.

h. Click on the OK  button to exit the DOS Only Prompt Properties 
dialog box.

6. Install the appropriate DOS or Windows NI-488.2 software for the 
AT-GPIB from your floppy drive.

a. For DOS, complete the following steps:

1. Close all open applications.

2. Double-click on the DOS Only Prompt icon.

3. Insert the NI-488.2 Software for DOS and the 
AT-GPIB/TNT+, AT-GPIB/TNT(PnP), EISA-GPIB, and 
AT-GPIB/TNT into your floppy drive.

4. At the DOS prompt, type x:\install  (where x  is the letter 
of your floppy drive).
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b. For Windows, complete the following steps:

1. Select Run from the Start menu.

2. Insert the NI-488.2 Software for Windows and the 
AT-GPIB/TNT+, AT-GPIB/TNT(PnP), EISA-GPIB, and 
AT-GPIB/TNT into your floppy drive.

3. Type x:\setup  (where x  is the letter of your floppy drive).

c. To run Win32 GPIB applications, copy the gpib-32.dll  
andgpib-16.dll  files from the Compatibility Release for 
the NI-488.2 Software for DOS and Windows 3 with 
Windows 95/98 disk into your Windows system directory 
(usuallyc:\windows\system ).

7. Restart Windows.

a. Select Shut Down from the Start menu.

b. In the Shut Down Windows dialog box, click on the Restart the 
Computer? option, then click on the Yes button.

8. Configure the software to use an AT-GPIB with the proper I/O, DMA 
and IRQ settings.

a. For DOS, complete the following steps:

1. Close all open applications.

2. Double-click on the DOS Only Prompt icon and switch into 
the directory where the NI-488.2 software for DOS was 
installed.

3. Type ibconf  to run the configuration utility.

b. For Windows, double-click on the GPIB icon in the Control 
Panel. You can open the Control Panel by choosing 
Start»Settings»Control Panel.

9. Restart Windows.

a. Select Shut Down from the Start menu.

b. In the Shut Down Windows dialog box, click on the Restart the 
Computer? option, then click on the Yes button.

10. Run the diagnostic tests.

a. For DOS, complete the following steps:

1. Close all open applications.

2. Double-click on the DOS Only Prompt icon and switch into 
the directory where the NI-488.2 software for DOS was 
installed.
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3. Type ibdiag  to run the hardware diagnostic test. If ibdiag  
fails because of a DMA problem, go back to step 8 and 
disable DMA. If ibdiag  fails because of an interrupt 
problem, go back to step 8 and disable IRQ.

4. After ibdiag  completes successfully, type ibtest  to run the 
software diagnostic test. If ibtest  completes successfully, 
the software and hardware are properly installed.

b. For Windows, complete the following steps:

1. Choose Start»Programs»NI-488.2 GPIB Software.

2. From the list that appears, select Hardware Diagnostic Test. 
If the test fails because of a DMA problem, go back to step 8 
and disable DMA. If the test fails because of an interrupt 
problem, go back to step 8 and disable IRQ.

3. After the Hardware Diagnostic Test completes successfully, 
bring up the list again and select Software Diagnostic Test. 
If both of these tests complete successfully, the software and 
hardware are properly installed.

11. (Optional) Run the interactive control utility.

a. For DOS, complete the following steps:

1. Close all open applications.

2. Double-click on the DOS Only Prompt icon and switch into 
the directory where the NI-488.2 software for DOS was 
installed.

3. Type ibic  to run the interactive control utility.

b. For Windows, complete the following steps:

1. Choose Start»Programs»NI-488.2 GPIB Software.

2. From the list that appears, select Win16 Interactive Control  
to run the Win16 version of the utility, or select Win32s 
Interactive Control  to run the Win32 version of the utility.
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Chapter

2GPIB-232/485CT-A

Follow the instructions in this section to use the GPIB-232CT-A or 
GPIB-485CT-A and the NI-488.2 software for DOS or Windows 3 with 
Windows 95/98.

What You Need to Get Started
❑ Compatibility Release for the NI-488.2 Software for DOS and 

Windows 3 with Windows 95/98 disk

❑ One of the following disks:

– NI-488.2 Software for Windows and the GPIB-232/485CT-A disk

or

– NI-488.2 Software for DOS and the GPIB-232/485CT-A disk

❑ Microsoft Windows 95 or Windows 98 installed on your computer

❑ GPIB-232/485CT-A getting started manual for additional information 
about the hardware installation

Install the Hardware and Software
1. Select an available COM resource for the GPIB-232/485CT-A 

hardware. The GPIB-232/485CT-A driver does not configure, acquire, 
or use hardware resources other than COM port designations. COM1 
through COM4 have standard base addresses and IRQ configurations. 
Other COM ports, if available, are configured either through Windows 
or through third party serial driver vendor utilities.

a. Double-click on the System icon in the Control Panel. You can 
open the Control Panel by choosing Start»Settings»Control 
Panel.

b. In the System Properties dialog box that appears, click on the 
Device Manager tab.
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c. Double-click on the Ports (COM & LPT)  item. The screen 
displays a list of COM ports that are set up in Windows. 

d. Choose an unused COM port from those that are set up. Connect 
that COM port to the GPIB-232/485CT-A hardware with your 
serial cable.

e. Click on the OK  button to exit the System Properties dialog box.

f. Close the Control Panel.

2. DOS only:  Create a Strictly DOS shortcut. The Strictly DOS shortcut 
shuts down Windows and gives you a DOS prompt. You must use this 
shortcut to run the NI-488.2 software for DOS and the 
GPIB-232/485CT-A. When you are finished using the software and 
hardware, you can simply type exit  to restart Windows. The NI-488.2 
software for DOS and the GPIB-232/485CT-A cannot be used in a 
standard DOS shell in Windows because Windows virtualizes the 
COM hardware. Complete the following steps to create the Strictly 
DOS shortcut:

a. Right-click on the desktop and select New. From the New menu 
list, select the Shortcut item. The Create Shortcut dialog box 
appears.

b. Click on the Browse button. Find the Dosprmpt item in the 
Windows directory (usually c:\windows ) and double-click on it. 
This initializes Command Line correctly and returns you to the 
Create Shortcut dialog box.

c. Click on the Next button and rename the shortcut icon to 
Strictly DOS.

d. Click on the Finish button to close the Create Shortcut dialog 
box. The Strictly DOS icon should appear on the desktop.

e. Right-click on the Strictly DOS icon and select the Properties 
menu item.

f. Select the Program tab and click on the Advanced button. The 
Advanced Program Settings dialog box appears.

g. Select MS-DOS mode. The Use current MS-DOS 
configuration item should also be selected. Click on the OK  
button to exit the dialog box. 

h. Click on the OK  button to exit the Strictly DOS Properties 
dialog box.
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3. Install the appropriate DOS or Windows NI-488.2 software for the 
GPIB-232/485CT-A from your floppy drive.

a. For DOS, complete the following steps:

1. Close all open applications.

2. Double-click on the Strictly DOS icon. Windows shuts down 
and gives you a DOS prompt.

3. Insert the NI-488.2 Software for DOS and the 
GPIB-232/485CT-A into your floppy drive.

4. At the DOS prompt, type x:\install  (where x  is the letter 
of your floppy drive).

b. For Windows, complete the following steps:

1. Select Run from the Start menu.

2. Insert the NI-488.2 Software for Windows and the 
GPIB-232/485CT-A into your floppy drive.

3. Type x:\setup  (where x  is the letter of your floppy drive).

c. To run Win32 GPIB applications in Windows 95 or Windows 98, 
copy the gpib-32.dll  and gpib-16.dll  files from the 
Compatibility Release for the NI-488.2 Software for DOS and 
Windows 3 with Windows 95/98 disk into your Windows system 
directory (usually c:\windows\system ).

4. Configure the GPIB-232/485CT-A for the selected COM port.

a. For DOS, complete the following steps:

1. Close all open applications.

2. Double-click on the Strictly DOS icon and switch into the 
directory where the NI-488.2 software for DOS was installed. 

3. Type ibconf  to run the configuration utility.

b. For Windows, double-click on the GPIB icon in the Control 
Panel. You can open the Control Panel by choosing 
Start»Settings»Control Panel. Skip to step 6 after the 
configuration utility runs.
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5. DOS only: Reboot your computer in order for gpib.com to load and for 
any changes to take effect.

a. Type exit  to return to Windows.

b. Restart Windows:

1. Select Shut Down from the Start menu.

2. In the Shut Down Windows dialog box, click on the Restart 
the Computer? option, then click on the Yes button.

6. Run the software diagnostic test.

a. For DOS, complete the following steps:

1. Close all open applications.

2. Double-click on the Strictly DOS icon and switch into the 
directory where the NI-488.2 software for DOS was installed.

3. Type ibtest  to run the software diagnostic test. If ibtest  
fails, refer to the Installation Verification and 
Troubleshooting chapter of the Getting Started with Your 
GPIB-232/485CT-A and the NI-488.2 Software for DOS 
manual. If you are using third party COM ports, you may 
need to refer to the manual that came with your COM port 
hardware.

b. For Windows, complete the following steps:

1. Choose Start»Programs»NI-488.2 GPIB Software. 

2. From the list that appears, select Software Diagnostic Test. 
If the test fails, refer to the Installation Verification and 
Troubleshooting chapter of the Getting Started with Your 
GPIB-232/485CT-A and the NI-488.2 Software for Windows 
manual. If you are using third party COM ports, you may 
need to refer to the manual that came with your COM port 
hardware.
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7. (Optional) Run the interactive control utility.

a. For DOS, complete the following steps:

1. Close all open applications.

2. Double-click on the Strictly DOS icon and switch into the 
directory where the NI-488.2 software for DOS was installed.

3. Type ibic  to run the interactive control utility.

b. For Windows, complete the following steps:

1. Choose Start»Programs»NI-488.2 GPIB Software. 

2. From the list that appears, select Win16 Interactive Control  
to run the Win16 version of the utility, or select Win32s 
Interactive Control  to run the Win32 version of the utility.
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Chapter

3GPIB-1284CT

Follow the instructions in this section to use the GPIB-1284CT and the 
NI-488.2 software for DOS or Windows 3 with Windows 95/98.

What You Need to Get Started
❑ Compatibility Release for the NI-488.2 Software for DOS and 

Windows 3 with Windows 95/98 disk

❑ One of the following disks:

– NI-488.2 for Windows Distribution Disk for the GPIB-1284CT 
disk

or

– NI-488.2 for DOS Distribution Disk for the GPIB-1284CT disk

❑ Microsoft Windows 95 or Windows 98 installed on your computer

❑ GPIB-1284CT getting started manual for additional information about 
the hardware installation

Install the Hardware and Software

Note For the Compatibility Release for the NI-488.2 Software in Windows 95/98, you 
cannot use the GPIB-1284CT and pass-through printing at the same time. This is 
because Windows virtualizes the LPT ports, thereby preventing simultaneous use 
of the LPT port by the printer and the GPIB-1284CT driver. If you alternate 
between using the GPIB-1284CT for pass-through printing and using it for GPIB 
access, you should not have any problems.



Chapter 3 GPIB-1284CT

Using NI-488.2 with Windows 95/98 3-2 © National Instruments Corporation

1. Select an available LPT resource for the GPIB-1284CT hardware. The 
GPIB-1284CT driver does not configure, acquire, or use hardware 
resources other than LPT port designations. LPTs have standard base 
addresses.

a. Double-click on the System icon in the Control Panel. You can 
open the Control Panel by choosing Start»Settings»Control 
Panel.

b. In the System Properties dialog box that appears, click on the 
Device Manager tab.

c. Double-click on the Ports (COM & LPT)  item. The screen 
displays a list of printer ports that are set up in Windows. 

d. Choose an unused LPT port from those that are set up. Connect 
that port to the GPIB-1284CT hardware with your parallel cable.

e. Click on the OK  button to exit the System Properties dialog box.

f. Close the Control Panel.

2. DOS only: Create a DOS Only Prompt shortcut to run the NI-488.2 
for DOS utilities rather than using the DOS shell from the 
Start»Programs»MS-DOS Prompt menu. Many NI-488.2 software 
utilities are combined DOS/Win16 applications. By default, Windows 
runs such combined applications in Win16 mode when executing them 
in a standard MS-DOS shell. For NI-488.2 for DOS, these combined 
applications must be run in DOS mode. Therefore, you must create a 
special DOS Only Prompt in which to run the NI-488.2 for DOS 
utilities. Complete the following steps to create the DOS Only 
Prompt shortcut:

a. Right-click on the desktop and select New. From the New menu 
list, select Shortcut. The Create Shortcut dialog box appears.

b. Click on the Browse button. Find the Dosprmpt item in the 
Windows directory (usually c:\windows ) and double-click on it. 
This initializes Command Line correctly and returns you to the 
Create Shortcut dialog box. 

c. Click on the Next button and rename the shortcut icon to DOS 
Only Prompt . 

d. Click on the Finish button to close the Create Shortcut dialog 
box. The DOS Only Prompt icon should appear on the desktop.

e. Right-click on the DOS Only Prompt icon and select the 
Properties menu item.

f. Select the Program tab and click on the Advanced button. The 
Advanced Program Settings dialog box appears.
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g. Select the first item, Prevent MS-DOS-based programs from 
detecting Windows. The Suggest MS-DOS mode as necessary 
item should also be selected. Click on the OK  button to exit the 
dialog box.

h. Click on the OK  button to exit the DOS Only Prompt Properties 
dialog box.

3. Install the appropriate DOS or Windows NI-488.2 software for the 
GPIB-1284CT from your floppy drive.

a. For DOS, complete the following steps:

1. Close all open applications.

2. Double-click on the DOS Only Prompt icon.

3. Insert the NI-488.2 for DOS Distribution Disk for the 
GPIB-1284CT into your floppy drive.

4. At the DOS prompt, type x:\install  (where x  is the letter 
of your floppy drive).

b. For Windows, complete the following steps:

1. Select Run from the Start menu.

2. Insert the NI-488.2 for Windows Distribution Disk for the 
GPIB-1284CT disk into your floppy drive.

3. Type x:\setup  (where x  is the letter of your floppy drive).

c. To run Win32 GPIB applications in Windows, copy the 
gpib-32.dll  and gpib-16.dll  files from the Compatibility 
Release for the NI-488.2 Software for DOS and Windows 3 with 
Windows 95/98 disk into your Windows system directory (usually 
c:\windows\system ).
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4. Configure the software to use a GPIB-1284CT with the proper 
Parallel  port  number , Type  of  parallel  port , and Interrupt 

Level  settings.

a. For DOS, complete the following steps:

1. Close all open applications.

2. Double-click on the DOS Only Prompt icon and switch into 
the directory where the NI-488.2 software for DOS was 
installed. 

3. Type ibconf  to run the configuration utility.

b. For Windows, complete the following steps:

1. Choose Programs from the Start menu and select MS-DOS 
Prompt. 

2. Switch into the directory where the NI-488.2 software for 
Windows was installed. 

3. To run the configuration utility, type:

wibconf x:\ path \gpib.ini

where x  is the drive and path  is the path of the Windows 
directory (usually c:\windows ).

5. Restart Windows:

a. Select Shut Down from the Start menu.

b. In the Shut Down Windows dialog box, click on the Restart the 
Computer? option, then click on the Yes button.

6. Run the diagnostic tests.

a. For DOS, complete the following steps:

1. Close all open applications.

2. Double-click on the DOS Only Prompt icon and switch into 
the directory where the NI-488.2 software for DOS was 
installed.

3. Type ibdiag  to run the hardware diagnostic test. If ibdiag  
fails because of an interrupt problem, go back to step 4 and 
disable the interrupt level.

4. After ibdiag  completes successfully, type ibtest  to run the 
software diagnostic test. If ibtest  completes successfully, 
the software and hardware are properly installed.
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b. For Windows, complete the following steps:

1. Choose Start»Programs»Gpib. 

2. From the list that appears, select ibdiag. If the test fails 
because of an interrupt problem, go back to step 4 and disable 
the interrupt level.

3. After ibdiag completes successfully, bring up the list again 
and select wibtest. If this test completes successfully, the 
software and hardware are properly installed.

7. (Optional) Run the interactive control utility.

a. For DOS, complete the following steps:

1. Close all open applications.

2. Double-click on the DOS Only Prompt icon and switch into 
the directory where the NI-488.2 software for DOS was 
installed. 

3. Type ibic  to run the interactive control utility.

b. For Windows, complete the following steps:

1. Choose Start»Programs»Gpib.

2. From the list that appears, select wibic to run the interactive 
control utility.
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Appendix

ACustomer Communication

For your convenience, this appendix contains forms to help you gather the information necessary 
to help us solve your technical problems and a form you can use to comment on the product 
documentation. When you contact us, we need the information on the Technical Support Form and 
the configuration form, if your manual contains one, about your system configuration to answer your 
questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to quickly 
provide the information you need. Our electronic services include a bulletin board service, an FTP site, 
a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first try the 
electronic support systems. If the information available on these systems does not answer your 
questions, we offer fax and telephone support through our technical support centers, which are staffed 
by applications engineers.

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of files 
and documents to answer most common customer questions. From these sites, you can also download 
the latest instrument drivers, updates, and example programs. For recorded instructions on how to use 
the bulletin board and FTP services and for BBS automated information, call 512 795 6990. You can 
access these services at:

United States: 512 794 5422
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635 551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com , as anonymous  and use 
your Internet address, such as joesmith@anywhere.com , as your password. The support files and 
documents are located in the /support  directories.



Using NI-488.2 with Windows 95/98 A-2 © National Instruments Corporation

Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a wide 
range of technical information. You can access Fax-on-Demand from a touch-tone telephone at 
512 418 1111.

E-Mail Support (Currently USA Only)
You can submit technical support questions to the applications engineering team through e-mail at the 
Internet address listed below. Remember to include your name, address, and phone number so we can 
contact you with solutions and suggestions. 

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technical 
support number for your country. If there is no National Instruments office in your country, contact 
the source from which you purchased your software to obtain support.

Country Telephone Fax
Australia 03 9879 5166 03 9879 6277
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Brazil 011 288 3336 011 288 8528
Canada (Ontario) 905 785 0085 905 785 0086
Canada (Québec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 26 02
Finland 09 725 725 11 09 725 725 55
France 01 48 14 24 24 01 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Israel 03 6120092 03 6120095
Italy 02 413091 02 41309215
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 5 520 2635 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden 08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
United Kingdom 01635 523545 01635 523154
United States 512 795 8248 512 794 5678



Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, and use 
the completed copy of this form as a reference for your current configuration. Completing this form 
accurately before contacting National Instruments for technical support helps our applications 
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem, 
include the configuration forms from their user manuals. Include additional pages if necessary.

Name __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

Fax ( ___ ) ________________Phone ( ___ ) __________________________________________

Computer brand____________ Model ___________________Processor _____________________

Operating system (include version number) ____________________________________________

Clock speed ______MHz   RAM _____MB Display adapter __________________________

Mouse ___yes   ___no     Other adapters installed_______________________________________

Hard disk capacity _____MB Brand_________________________________________________

Instruments used _________________________________________________________________

_______________________________________________________________________________

National Instruments hardware product model _____________ Revision  ____________________

Configuration ___________________________________________________________________

National Instruments software product ___________________ Version  _____________________

Configuration ___________________________________________________________________

The problem is: __________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

List any error messages: ___________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

The following steps reproduce the problem: ___________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________



Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our products. 
This information helps us provide quality products to meet your needs.

Title: Using Your NI-488.2™ Software for DOS or Windows 3 with Windows 95/98

Edition Date: June 1998

Part Number: 370901A-01

Please comment on the completeness, clarity, and organization of the manual.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

Thank you for your help.

Name _________________________________________________________________________

Title __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

E-Mail Address __________________________________________________________________

Phone ( ___ ) __________________________  Fax ( ___ ) _______________________________

Mail to: Technical Publications Fax to: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway 512 794 5678
Austin, Texas 78730-5039
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